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Overview	
 
First, the definitions of takeoff and estimating: 
 

 Quantity Takeoff is done by measuring items and then applying calculations to these basic 
measurements. 
 

 Estimating is assigning costs to these quantities. 
 
When BidScreen XL is added to Excel, BidScreen XL measures items from construction plans and 
automatically records the measurement and color coded drawing into any Excel cell.  Additional 
calculations to these BidScreen XL measurements are performed through Microsoft Excel formulas and 
functions to arrive at the takeoff quantity.  Assigning the estimated cost to the quantities (i.e. estimating) 
is then done in an Excel workbook or through a relational database estimating program.   
 
An accurate estimate must start with the proper measurements and takeoff quantities.  When creating an 
estimate, the quantity takeoff is often the most time consuming activity and one that could result in errors 
and omissions.  By using BidScreen XL with Excel, your productivity, accuracy, confidence and 
knowledge should increase substantially.  
 
We, like most contractors, believe that organizing your takeoff quantities in Microsoft Excel, regardless 
of the software used for estimating, is often the easiest, most logical and best way to document the takeoff 
quantities. With this in mind, BidScreen XL is software that is added to Microsoft Excel that measures 
items directly from digital files such as PDF, TIFF, and AutoCAD DWG. A clear, concise audit trail of 
the measurement is recorded automatically into Excel. 
  
Due to the widespread use and power of Excel, we promote Excel based takeoff and estimating and have 
included a collection of workbook files for your use and review.  Many of our customers have created 
their own Excel estimating template and use BidScreen XL with their own spreadsheets.  Others use the 
included Excel workbooks and customize these takeoff and estimating templates to fit their needs.  After 
installing the software, the Excel takeoff and estimating workbooks provided with BidScreen XL can be 
opened from the BidScreen XL programs list (Start|All Programs|BidScreenXL|Example Workbooks). 
 
Please note that certain divisions of work, such as site excavation and some of the mechanical trades may 
be better served by performing the quantity takeoff in trade specific, non-spreadsheet applications.  For 
site excavation, Vertigraph’s SiteWorx/OS software is ideal for creating 3D models of the site and 
calculating cut and fill volumes.  Contact Vertigraph today for a free evaluation copy of this easy to use, 
affordable SiteWorx/OS software or go to www.vertigraph.com and download a working copy. 
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Installing	BidScreen	XL	and	adding	it	to	Excel	
 

BidScreen XL is an Excel add-in application that must be added to Microsoft Excel.  BidScreen XL 
cannot be run by itself.  You run BidScreen XL by opening Microsoft Excel.  
 
Which version of BidScreen XL to install is determined by the flavor of Excel, 32 bit or 64 bit?  If the 
Excel version is before Excel 2010, you’re assured that you’re using the 32 bit version.   To find out 
which edition of Excel 2010 you’re using, click File | Help in Excel and look on the right under About 
Microsoft Excel. The version of the activated product is listed with the number of bits. 
 

 
 
 
 
In order to install the BidScreen XL 64 bit version, you’ll need to be running the 64 bit Excel version, 
which will be Excel 2010 or later.  If the Excel version is 32 bit, you’ll install the 32 bit version of 
BidScreen XL.   

After downloading and installing the appropriate BidScreen XL version, BidScreen XL must be "added" 
to Excel.  This new and improved BidScreen XL version 6 software adds a BidScreen XL ribbon tab to 
Excel.  Previous versions of BidScreen XL added a toolbar to Excel.  For users still running pre 2007 
Excel versions, the BidScreen XL toolbar, rather than the BidScreen XL ribbon, will be added to Excel 
2007.  
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After downloading and installing BidScreen XL, you must first add the BidScreen XL ribbon or toolbar to 
Excel.  The BidScreen XL ribbon file is named BidScreenXL_7.xlam.  The BidScreen XL toolbar file is 
named BidScreenXL.xla.  Only Excel 2003 versions and older should add the toolbar (i.e. 
BidScreenXL.xla).  Excel 2007 and later should add the preferred BidScreen XL ribbon (i.e. 
BidScreenXL_7.xlam). 

 
1. 64 bit and 32 bit Excel version 2010 and later must use the BidScreen XL Ribbon 

 Open Excel and left click on File | Options.  
 Select the Add-Ins option on the left side of the window.  
 At the Add-ins windows, click the Go… button at the bottom of the page.  
 This will display a list of Add-ins. Click the Browse... button to locate 

BidScreenXL_7.xlam.  
 The BidScreenXL_7.xlam file will be found in the C:\Program 

Files\Vertigraph\BidScreen XL folder if the files were installed to the default directory. 
When running Excel 32 bit under 64 bit Windows, this BidScreenXL_7.xlam file will be 
found in the C:\Program Files(X86)\Vertigraph\BidScreen XL folder. 

 Highlight the file and press OK.  
 Press OK on the Add-Ins list to complete the process.  
 A registration dialog should appear. Press No.  
 A BidScreen XL tab should appear in the row of tabs at the top of the Excel window. If the 

BidScreen XL tab does not appear, please close and restart Excel.  

 
2. Excel version 2007 installation should also use the BidScreen XL Ribbon 

 Open Excel and right click on the Office button in the top left corner of the menu bar and 
select Customize Quick Access Toolbar.  

 Select the Add-Ins option on the left side.  
 At the Add-ins windows, click the Go… button at the bottom of the page.  
 This will display a list of Add-Ins. Click the Browse... button to locate 

BidScreenXL_7.xlam.  
 The BidScreenXL_7.xlam ribbon file will normally be found in the C:\Program 

Files\Vertigraph\BidScreen XL folder if operating a 32 bit version of Windows.  If 
operating a 64 bit version of Windows, the BidScreenXL_7.xlam file will be found at 
C:\Program Files (x86)\Vertigraph\BidScreen XL.  

 Highlight the file and press OK.  
 Press OK on the Add-Ins list to complete the process.  
 A registration dialog should appear. Press No.  
 A BidScreen XL Tab should appear in the row of tabs at the top of the Excel window. If the 

BidScreen XL tab does not appear, please close and restart Excel.  

3. Installation of Excel versions before 2007 must use the BidScreen XL toolbar 

 Open Excel and click on the Tools | Add-Ins menu.  
 Press the Browse button to select the BidScreenXL.xla toolbar add-in file.  
 The BidScreenXL.xla file will be found in the C:\Program Files\Vertigraph\BidScreen XL 

folder if the files were installed to a 32 bit Windows operating system.  If the Windows 
Operating System is 64 bit, this BidScreenXL.xla file is found at C:\Program Files 
(x86)\Vertigraph\BidScreen XL. 



 6

 Highlight the file and press OK.  
 Press OK on the Add-Ins list to complete the process.  
 A registration dialog should appear. Press No.  
 After adding BidScreen XL to your Excel application a BidScreen menu is added to the 

Excel menu bar and a BidScreen toolbar is added to Excel. If the BidScreen toolbar and 
menu are not active, please close and restart Excel.  

For your information, the BidScreen XL program files get installed to the following folders: 
 

a) 32 bit BidScreen XL on 32 bit windows - C:\Program Files\Vertigraph\BidScreen XL 
 

b) 32 bit BidScreen XL on 64 bit windows - C:\Program Files (X86)\Vertigraph\BidScreen XL 
 

c)  64 bit BidScreen XL on 64 bit windows - C:\Program Files\Vertigraph\BidScreen XL 
 

Items	Added	to	the	BidScreen	XL	Program	Group	
 

After installation, A BidScreen XL program group is added to the All Programs listing that is displayed 
after clicking the Windows start button.  As noted previously you must open Excel to use the BidScreen 
XL software.  It does not run by itself.  Under this BidScreen XL program group the following ten items 
are installed: 

1. BidScreen Reference viewer 

The BidScreen XL Reference viewer is for viewing any file.  It is ideal when seeking detail 
information on a plan sheet that has not been loaded to Excel.  If Adobe Acrobat Version 7 or 
newer is installed on your computer, this Reference Viewer will open Adobe Acrobat when 
opening a PDF file. 

2. BidScreen XL Help 

Opens the BidScreen XL Help file 

3. BidScreen XL User Guide 

The BidScreen XL User Guide is this PDF file which you are currently reading. 

4. BidScreen XL on the Web 

Opens www.vertigraph.com 

5. CPC File Converter 
 
The Vertigraph CPC Conversion Utility converts Cartesian Products CPC and CPI files into TIF 
files. It is a "batch" converter and will convert all the files of the selected type in the selected 



7 
 

folder.  CPC and CPI files are compression files which must be decompressed before using.  This 
file converter utility decompresses CPC and CPI files. 

6. Example Workbooks 

The Excel workbooks item contains a list of Excel workbooks for automating the takeoff and 
estimating process.  Feel free to use and customize these Excel workbooks as you see fit. 

7. Support Meeting 

Vertigraph’s customer service team can assist you online during a phone call.  The support 
meeting command lets Vertigraph see what is happening on your computer while you’re 
operating BidScreen XL.  You can also view our computer screen for training and support with 
this command. 

8. Tiff Resizer 

Occasionally certain tiff files may be too large to properly display on the screen based on the 
pixel count.  This command reduces the size and resolution of these files. 

9. Uninstall BidScreen XL 

This command removes the BidScreen XL software from the hard drive.  Before uninstalling, 
please remove the Excel add-in from Excel 2010 by clicking on File | Options | Add-in under 
Excel 2010 and then press the Go button to uncheck the add-in. 

10. Windows Version 

This command is useful for technical support and supplies information regarding the Windows 
Operating system, BidScreen XL and, if installed, Adobe Acrobat. 
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Quick	Start	‐	BidScreen	XL	in	Eight	Steps	
 

After adding BidScreen XL to Excel measuring with BidScreen XL is easy.  Simply follow the basic 
steps: 

1. Click on the BidScreen XL menu in Excel to display the BidScreen XL ribbon 
2. Load the drawing(s) and click the green checkmark to accept. 
3. Autoscale or set the scale for each loaded file.  For vector, Cad files such as DWG files, a 

drawing unit is defined rather than a scale.  
4. Click on the Project/Drawing Manager tab to load files, rename loaded files, remove 

loaded drawings and record annotations and highlights to any of the drawings. 
5. At the BidScreen XL ribbon, click on the cell where you want the quantity measurement 

placed and then select the desired drawing file from the list box. 
6. Select the takeoff measurement command from the toolbar or menu (i.e. Count, Section 

Length, Continuous Length or Area).   
7. Begin measuring by clicking with the mouse.  While measuring, activate the right mouse 

button, menu, toolbar and shortcut keyboard keys to apply the available commands to the 
measurement. 

8. To record the measurement and color coded drawing into an Excel cell, click the green 
checkmark or right click the mouse button to stop the takeoff measurement.   
 

After digitizing the measurement, a red cell comment is placed in the top right hand corner of the cell.  
This Excel cell comment informs the user where measurements have been recorded with BidScreen XL.  
The cell comment also contains information about the color coded digitized drawing.  After clicking on a 
cell with a red cell comment, the type of measurement will be displayed on the top right hand corner of 
the ribbon after TO Type.  There are four takeoff types:  Count, Section Length, Continuous Length and 
Area.  To view the digitized drawing, select the Takeoff command that corresponds to its takeoff type. 
To delete a cell comment and measurement, click on the desired cells (hold down the Alt key on the 
keyboard to click on nonadjacent cells) and click the delete Takeoff command on the ribbon.  
Alternatively, measurements defined by red cell comments may be deleted by clicking on the cells with 
cell comments, right click the mouse and select Delete Comment and Clear Contents. 

Zooming	In	and	Out	and	Moving	Around	(Panning)	the	Drawing		

When viewing and measuring a drawing, moving around and zooming efficiently is critical. 

 Zoom in and out by using the scroll wheel on the mouse.  Alternatively, holding down the Shift 
key on the keyboard while clicking the mouse also activates zoom.  Shift + Left mouse click 
zooms in.  Shift + Right mouse click zooms out. 

 Once zoomed in, move around the drawing (i.e. pan) by holding down the CTRL key on the 
keyboard as you drag and drop with the mouse.   
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Several menu commands are not found on the Ribbon and are worth mentioning here for the proper 
operation of BidScreen XL.  As a result, the following three menu commands are discussed below. 

 

1. Setup 

Setup defines how BidScreen XL operates.  To change any of the default setup commands, click on the 
Menu | Setup command to setup and configure BidScreen XL. Normally, there is no need to change 
these setup settings once BidScreen XL has been properly configured or setup.  If changes were made to 
setup and you want to return to the default settings, click the Default button on the right side to set the 
options to the recommended settings.  Details regarding the setup options are found by clicking on 
Takeoff Help. 

Two items configured under the default setup should be changed for some customers however.  First, the 
default scale unit setting is set to English Architectural (i.e. 1/4”, 1/8”, 1/16” etc.).  If the majority of the 
drawings are Metric or English Engineering scale, change the default scale units at the Menu | Setup | 
Drawings tab.   

Secondly, when loading multiple files and pages, some users would like to review the drawing before 
instructing BidScreen XL to load the file or page.  At the Menu | Setup | Options tab if Accept Multiple 
Drawings is enabled, each page of a multiple page open, or each file of a multiple file open will be 
displayed. The page or file can then be accepted or rejected. If this option is disabled, then all pages or 
files are automatically accepted and added to the drawing list. The default setting for this option is 
disabled and is always disabled, regardless of the setting, when loading files at the Drawing Manager.  

2.  Create Template 

This command eliminates all measurement and drawing information from the workbook.  All BidScreen 
XL information found on the workbook will be erased with this command.  Once the information is 
erased from the workbook it will not come back. As a result, proceed with caution when using this 
command.   

3. Change Scale 

Change Scale is used to change the calculated result for a measurement that was digitized using the wrong 
scale.  This command is used only to correct mistakes resulting from an incorrect scale of previous 
measurements.  Click on a cell or cells with a red BidScreen XL cell comment in the top right hand corner 
of the cell and then select this command to change the scale.  The scale and measurement values in the 
cells will change as a result.   
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Drawing	Tools	on	the	Ribbon	
 

 

The Drawing group has 4 items: 

Manage/Project/Drawings 

The Manage/Project Drawings has two tabs:  Project and Drawings. 

The Project Tab overrides the default values for the current project only and allows dual scales on 
drawings loaded to the current workbook.   

Changing these values does not change the values defined in the setup dialog at Menu | Setup.  The 
fourth thru sixth items on the Reports section of the Project tab will change the values that print on the 
report.  If information is entered here, the Show Report Title Dialog may be unchecked when printing 
the report.  

The Use Dual Scales checkbox must be turned on (i.e. checked) if any drawing files loaded to the current 
workbook contain different horizontal and vertical scales.  Certain cross sections and utility drawings may 
contain more than one scale.   After loading the drawing(s), you may specify a drawing as a Dual Scale 
drawing at the Drawings tab when Use Default Scales is checked at the Project tab. 
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The Drawings tab contains a listing of all of the files loaded to the current project (i.e. Excel workbook). 
 
When clicked on a file name, the drawing displays to the right.  At the Drawings tab of the 
Project/Drawing Manager the following features are available: 
 
 Zoom by using the scroll wheel on the mouse or Shift key on the keyboard + Left mouse click to 

zoom in and Shift + Right Mouse click to zoom out.  Once zoomed in, Pan or move around by 
holding down the keyboard Ctrl key as you drag and drop the mouse. 

 
 An annotation and highlight toolbar is available for placing items onto the drawing. 

 

 
 
A chief estimator may load the drawings and make various comments and highlights to the 
drawings before that takeoff is completed by a different takeoff specialist. 
 

 The drawing path of the file is displayed. 
 
 A user defined description may be recorded in the description box that will more clearly define 

the file name. 
 

 Selected files may be hidden so that they will not appear and be available from the Drawing List. 
 

 A file or group of files may be loaded at the Project/Drawing Manager by clicking the Load 
button. 
 

 Before measuring from a drawing, the drawings may be rotated and de-skewed here by clicking 
on the Rotate button and then click on the Drawings menu to rotate and de-skew the drawing. 
 

 The default scale may be set here for any drawing.  You cannot change the scale here however. 
To change the scale after it has been set, select the drawing and click on and Excel cell and then 
scale button on the BidScreen XL ribbon to change the default scale. 
 

 Certain default values for scale units, dual scales, rounding and CAD file attributes are initially 
set at Menu | Setup are then recorded to the Project tab.  The values from the Project tab are 
recorded to the Drawings tab when each drawing is loaded.  These values may be changed at the 
Project tab and/or Drawings tab as needed.  Ideally, changes to these values will be done 
infrequently.  

 

Load Drawing 

The Load Drawing tool is how you load drawing files.  In order to measure from a file, the file must first 
be loaded to the Excel workbook.   
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Please note: 

 After clicking on a file, wait until the drawing displays on the right side of the Open Drawing File 
window. 

 OPEN - After the drawing displays, click the Open button to load the selected file. 

 FILES - The Files button loads many files with a single click by loading all files in the folder of 
the selected type. 

 PAGES - The Pages button loads the pages of a multiple page file. 

 If the Accept Multiple Drawings is enabled under the Options tab of the Menu | Setup, each 
page of a multiple page open, or each file of a multiple file open will be displayed. The page or 
file can then be accepted or rejected. If this option is disabled under Menu | Setup, then all pages 
or files are accepted and added to the drawing list automatically. 

 If you open a file that is too large, BidScreen XL will resize the drawing and you will be asked to 
save the file.  Saving a resized file as a .CMP file will open the drawing faster. 
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Browse Drawing 

Browse Drawing opens Internet Explorer to browse the Web and to locate and save drawing files. 

Drawing List 

The drawing list contains the list of files loaded to this workbook. The description will be the file name 
and page or the user defined description recorded at the Manage Project/Drawings window. The file 
displayed at the top, is the active file.  Whenever a takeoff command (i.e. Count, Section Length, 
Continuous Length and Area) is selected, the active file displays.  

	

	

Takeoff	Tools	on	the	Ribbon	

 

The takeoff commands are used for measuring, printing and deleting.  There are three types of 
measurements- count, length and area.  Please note: 

o The active drawing appears after selecting the count, section length, continuous length or area 
command. 

o While measuring, zoom with the scroll wheel and move around by holding down the Ctrl 
keyboard key. 

o Click on the mouse button to digitize a line, area or count point.  When digitizing areas and 
continuous lengths, it is easiest to click the change in direction point rather than tracing.  

o To end an area or continuous length press the keyboard Enter key before starting a new one.   

o To record the value and drawing into the Excel cell, click the green checkmark. 

o A red Excel cell comment is placed on the cell where the measurement is recorded and indicates a 
color coded drawing is associated with the value in the cell.  The cells with drawings may be 
copied and moved within the Excel workbook. 

o The Backspace keyboard key deletes the last point. 
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o Instead of deleting with the backspace keyboard key, select any previously digitized object by 
right clicking the mouse, click Select Object and move the square selection box over a point and 
left click.  After the point is selected, click the right mouse button to delete the object.  

o The point, line and area symbols are defined in the styles library and may be changed at any time 
through the menu, toolbar or palette if enabled under Menu | Setup. 

o While digitizing with the left mouse button, additional commands are available through the 
toolbar, menus, right mouse button popup menu and keyboard shortcut keys. Many users find the 
keyboard shortcuts to be quickest way to activate the commands. 

o If the scale is Metric, the unit of measure is meters.  If English, the unit of measure is feet. 

o At View | Takeoff select All or Current to display either the current cell’s color coded drawing 
or all of the color coded digitized drawings from the file. 

o While measuring, display the magnifying or panning window by clicking on the desired option 
under the view menu. 

o Press the minus sign on the keyboard, or press the right mouse popup menu to subtract areas or 
lengths while measuring.  When negative is turned on, the area or length value caption at the top 
of the window will display in red.  Turn off the negative by using the menu, popup menu or the 
appropriate shortcut keyboard key (i.e. + sign on the keypad).  When measuring negative areas 
the perimeter length value will be added, rather than subtracted, from the total length value. 

o Lengths and areas of circles are measured by clicking on three points around the circumference 
after activating the Circle command from the Edit menu, right mouse button popup menu or by 
the shortcut keyboard keys.   A rectangle may be measured by clicking on three corners 
clockwise or counter clockwise after selecting the Rectangle command from the Edit menu, right 
mouse button popup menu or by the shortcut keyboard keys. 

o When measuring area and continuous lengths, click one point and then select the Arc command 
from the Edit menu, right mouse button popup menu or by the shortcut keyboard keys to draw 
curved lines or arcs.  After select the Arc command, click the high and low point of the arc to 
draw the line. 

o For circles, rectangles and arcs, the line is not drawn on-screen until the last point is clicked. 

o Lengths, but not areas, may be rounded up or down by setting a degree of precision at the 
Options menu at the Takeoff window.  
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Scale 

If the active drawing does not have a scale, set the scale before measuring.   

 

 Setting the proper scale is extremely important and drives the measurement numbers.  If the scale 
is incorrect, the measurement values will also be incorrect.   

 We recommend that the scale be calibrated by clicking on the Autoscale button. 

 After setting the scale, the scale factor is displayed.  For English scales, the scale factor is the 
reciprocal of the scale times 12.  A quarter inch scale will have a factor of 48.  A 1 to 50 scale 
will have a factor of 600.  Scales that have been calibrated using the Autoscale button will usually 
have a factor with decimal values.  

 English scales always measure areas in square feet and lengths in linear feet.  If you seek a 
different unit of measure, square yards instead of square feet for example, you’ll use Excel 
formulas to calculate the square yards in a different, adjacent cell.   

 The factor on Metric scales is the reciprocal of the scale.  Metric scales measure areas in square 
meters and lengths in linear meters.  

 If a file is a vector drawing file, such as AutoCAD DWG, the unit of measure for the file is used 
rather than a scale. 

Count 

The count command simply counts items. 

Section Length 

The Section Length command measures disconnected straight line lengths. Length measurements are in 
feet for English scales and meters for Metric scales. Use Continuous Length and not Section Length on 
curved lines.    
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Every section line has only two points – beginning point and end line point.  When the section length 
count is an odd number, it indicates that you have clicked on the beginning point of a line and you’ll need 
to click the end point to complete.  When the section length count is an even number, you can either stop 
the takeoff or start a new line.  When doing section lengths, it is beneficial to think in terms of beginning 
of line point and end of line point.  When digitizing around a corner with section lines, click the corner 
twice, once to end the line and again to start the next line from the corner.  If you incorrectly think you are 
clicking on an end of line point, when you are actually clicking on a beginning of line point, your values 
will be misstated.  As a result, many professionals use continuous length to measure all lengths.      

Continuous Length 

Continuous Length measures lengths by clicking along the line.  To stop one line and start another, press 
the Enter keyboard key.  To record the length into an Excel cell, click the green checkmark. 

After digitizing at least one point on a curved line, select the Arc command, using the keyboard shortcut 
or right mouse pop up menu, and click on the peak and end of the curved line.  

 

Area 

To measure an area, click around the perimeter either clockwise or counter clockwise.  When you arrive 
back to the original point, press the Enter key on the keyboard to close the area. Areas are calculated in 
square feet for English scales and square meters for Metric scales. 

Three numbers are generated while measuring areas: count, length and area.  To record the perimeter 
length of an area, end the area measurement in one cell and then move to a new, blank cell and select the 
Continuous Length command.  After the drawing displays, accept the measurement by clicking the green 
checkmark to record the perimeter length of the last area viewed and accepted into that cell.  Again, when 
measuring negative areas, the perimeter lengths on negative areas are added, not subtracted, to the 
perimeter length. 

 

Print 

After recording the measurement into an Excel cell, a red cell comment (i.e. a red dot in the top right hand 
corner of the cell) will be placed onto the cell.  The red cell comment indicates a color coded drawing is 
attached to the measurement value in the cell.  

1. When printing the drawing, first select the drawing cell(s) that have a red comment indicator that 
will be included on the printout.  You may select one cell or any combination of cells to include 
on the printout.  To select non adjacent cells, hold down the Ctrl keyboard key while clicking on 
cells that have red cell comments. The cells selected must be from the same drawing file 
however.  
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2. After selecting the desired cells from the same drawing, click the Print command to display the 
Title block dialog window.    

3. After filling out the title block dialog, click OK to display the BidScreen XL Print Preview. 

 

 

The print preview window has a toolbar with various print commands. 

 

Please note: 

 Pointing at the tool with the mouse displays a popup description of the tool. 

 The Show Measurements tool on the right side displays each length and area measurements.  For 
example, the value in the cell may include one number that is the total square footage of two area 
measurements.  When Show Measurements is pressed down and activated, the area measurement 
for each individual area will be displayed on the print preview. 
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 The Show Style Legend tool on the right side displays the style legend on the printout.  If you 
have a lot of styles, you may want to print this style legend solely on a blank page.  To print the 
style legend on a blank page, check the Print Style Legend on a 2nd page checkbox on the Print 
Options tool which is next to the Print setup tool. 

 To print in landscape and/or portrait mode, click on the Toggle Portrait/Landscape tool at the 
top of the BidScreen XL print preview window.  Pointing at the tools with the mouse pointer 
displays a description of the tool. 

 On the far right side of the toolbar, is the print scale.  You may print a scaled drawing of the 
takeoff. To change the scale use the scroll wheel on the mouse or change the scale by clicking on 
the down arrow to the right of the print scale tool. 

Delete Takeoffs 

This command deletes the value in the cell along with the color coded digitized drawing attached to the 
cell.  The cell comment will be erased.  To select multiple non-adjacent cells, hold down the Ctrl key on 
the keyboard as you click on the cells that have digitized drawing cell comments. After the cells are 
selected, click the Delete Takeoffs tool to delete all of the selected cells. Be careful when using this 
command, once the value is deleted it cannot be reversed. 

Takeoff Help 

Opens the BidScreen XL Help file. 

Information Displayed on the Right Side of the Takeoff Tools 

TO Type 

When clicked on a digitized cell that contains a red cell comment, the type of measurement is displayed 
after TO Type.  Click the takeoff command pertaining to the TO Type to view the digitized drawing.  For 
example, if TO Type shows Area, click the Area command to see the color coded drawing.   At the 
BidScreen XL Takeoff Window, select View | Takeoff | Current to see solely the drawing that pertains 
to the measurement value in the cell. 

Scale 

The scale is determined by the factor.  A scale will be displayed here if the factor calculates to within 5% 
of a listed scale.    

Factor 

The factor is what BidScreen XL uses to calculate areas and lengths.  If the scale is selected at the Scale 
dialog, the factor will be the reciprocal of the scale time 12 for English scales.  For example, a 1/8” scale 
will have a factor of 96 (8x12). For metric scales the factor is the same as the scale.  When Autoscale is 
used, the factor will often have decimal places. 
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The	BidScreen	XL	Takeoff	Window		

After selecting the Count, Section Length, Continuous Length or Area command the BidScreen XL 
Takeoff Window appears.  

  

Please note: 

 Commands are available from the menu bar, toolbar, keyboard shortcut keys and by right clicking 
the mouse to activate the popup menu. 

 All users should become familiar with the menu, right mouse pop up menu, and keyboard 
shortcut commands that are available from the Takeoff window. 

 To learn about the various menus, tools and options when at the Takeoff window, click the 
question mark Help tool.  When Takeoff Window help is displayed, click the menu, ribbon or 
whatever on the displayed Takeoff Window to obtain an explanation.  The Takeoff window is 
broken down into six parts from top to bottom 

1. Title Bar is the name of the window 
2. Menu Bar contains the various menus and submenus 
3. Takeoff Ribbon contains BidScreen XL tools. 
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4. Information Bar is a single line containing information right under the toolbars and above 
the drawing. 

5. Drawing is the plan file. 
6. Status Bar is a single line of instruction and status found on the bottom line of the 

window. 

How	to	Delete	all	BidScreen	XL	information	from	a	Workbook	
 
To eliminate and erase all BidScreen XL information from an Excel workbook select Menu | Create 
Template. An Excel file will be created with all BidScreen XL removed. 
 
Once the information is erased from the workbook, it will not come back. As a result, be careful when 
using this command. 

The	Importance	of	Adobe	Acrobat	with	BidScreen	XL		
 
BidScreen XL will use Adobe Acrobat to open PDF files when Adobe Acrobat Version 7 or 
higher is installed.  Adobe Acrobat is different from Adobe Reader.  Vertigraph highly recommends 
having Adobe Acrobat installed since it insures 100% compliance when reading PDF files. 
 
Adobe Acrobat offers other features that are beneficial to BidScreen XL users.  These beneficial 
features include drawing rotation, extracting pages from a multiple page PDF files, editing PDF 
files and saving files under a different file format.  With the Adobe Acrobat Pro version compare 
tool you can review the differences between two PDF files. 
 
Before adding files to an Excel workbook, it is recommended that you should first review the 
files with Adobe Acrobat.  If you have a multiple page file, please extract those pages that you’ll 
load to Excel as separate files into a separate folder.  After extracting the pages, use Adobe 
Acrobat to rotate and then save these rotated files if necessary.  Once the pages are extracted as 
separate files and rotated if necessary, load all the files into Excel with a single click by clicking 
the Files command at the Open Drawing File window.     
 
Vertigraph bundles Adobe Acrobat with its BidScreen XL software at special discounted pricing.  
Contact us today for the bundled pricing. 

How	to	Create	a	Quick	Access	Toolbar	in	Excel	2010	

The commands added to the BidScreen XL tab in Excel 2010 may also be added to the Excel 2010 title 
bar.  A quick access toolbar saves time and does not require clicking on the BidScreen XL tab to activate 
the commands.  Adding a Quick Access Toolbar to the title bar will save a mouse click for those seeking 
maximum efficiency. 
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To add the quick access toolbar to the title bar, follow these steps: 

1. In Excel 2010, click on File | Options. 

2. At the Excel options window click on Quick Access Toolbar on the left side. 

3. When Customize the Quick Access Toolbar window appears, choose commands from the 
BidScreen XL Tab by clicking on the down arrow at the top of the window. 

 

The BidScreen XL commands will appear on the left side of the window.  To add a command to the 
Quick Access Toolbar Simple, highlight the command with an icon and press the Add button. 
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Information	about	Vector,	CAD	files	

Architectural drawings are either vector or raster files.  A raster image, such as a TIFF, PDF, BMP, and 
JPEG file, is a data file representing a grid of pixels (dots) on a computer monitor.  A vector file on the 
other hand represents an image in computer graphics created through the use and assembly of 
geometrical, mathematical shapes such as points, lines, curves and polygons.  AutoCAD DWG and DXF 
files are examples of vector files.   

BidScreen XL operates differently depending on the type of file (i.e. vector or raster) loaded.  

Please note the following: 

 The big advantage of CAD, vector file is the ability to snap to the design object while measuring 
with your mouse.  At the BidScreen XL Takeoff window select Options | Snap to Object to 
activate this feature when working with vector CAD files.  When Snap to Object is turned on, the 
mouse pointer will be a square selection box. If Snap to Object is on, you’ll obtain the exact 
measurements from the design object. 

 A computer aided design file (i.e. vector file) is a collection of design layers. With a vector file 
(e.g. AutoCAD DWG file) design layers may be turned on and off.  If a design layer is not 
relevant to the current takeoff, it may be eliminated from view.  Select CAD | Layers to select 
which design layers to display from a vector file. 

We	Thank	You	

We thank you for your evaluation and business.  If you have questions, problems or suggestions please 
contact us at any time. 

 
Vertigraph, Inc. 
12959 Jupiter Road, Suite 252 
Dallas, TX 75238 
214-340-9436 
800-989-4243 
support@vertigraph.com 
www.vertigraph.com 


